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Chapter 1. Getting Started 

Installation 

Backing up your files 

If you already have Easy-PC installed, please remember to back up all your libraries, Technology 

files and any other data files before proceeding with the installation of the new version. The installer 

should not overwrite any of your own named files, but it can re-install new copies of our standard 

data files so if you have changed any of those files it is important to back them up first. If you are 

uncertain, check the time/date stamp on the file but in any case, make a back-up. 

Of course, backing up your data is important not only for the upgrade but also at regular intervals 

during design. 

Installation from a download link 

A download link for the installation of Easy-PC would have been provided to you by email. Click on 

the link to download the executable named EasyPC.exe. This is the whole installation set and should 

be saved and backed up for future use. Any subsequent patches can be installed on top of this ‘base’ 

setup once installed. 

Using Windows Explorer, find the executable in your Downloads folder and double-click it. You’ll 

need to type (or copy/paste) the password provided to unpack this file. Once the unpack password 

has been successful, you will be allowed to continue with the installation. You will also need to have 

your customer ID number that will be in the download link and your 16-digit installation code to 

fully install the product. 

All other instructions should be followed until you click Finish to complete the installation. 

The installation is the same for new and existing users alike. Existing users with versions prior to this 

latest version can install the new software over an existing installation without deleting the old one 

first. 

Installation From CD 

CDs are no longer supplied; a download link would have been supplied to you by email. Under 

special circumstances, product on CD media can be purchased if you contact our sales office. 

Installing over existing Easy-PC software 

If you already have an earlier version of Easy-PC installed on your system and you wish to install the 

new version into the same folder as the earlier one, please note that you will then end up with both 

versions listed in the Windows Control Panel list of installed applications.  

If you don’t want the earlier one to be listed in the Control Panel, you will need to un-install that 

version before you install the new one. If you install the new software into the same folder as the old 

version then try to un-install the old one, you will find that the new software will not run as the un-

install will have removed many or all of the program files. 

If you wish to install and use the new version without removing the old one, you will need to install 

the new version into a different folder. The two versions will then operate independently and either 

can be un-installed without preventing the other from running. 

Uninstalling Existing Easy-PC Software 

Uninstalling will still remove shared registry entries, so it is recommended that a configuration file be 

saved first using the Configuration Files option from the Help menu and Support option. This will 

provide a restore point for any settings which may be lost. 
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Data Files Location 

There is a step in the Setup installation wizard that asks you where you want to place data files (for 

example, Libraries, Technology files, etc). The default is always to use the common documents 

folder, C:\Users\Public\Documents\Easy-PC on Windows 8.1 or 10 if you are installing for All Users, 

or into your own Documents folder if installing for current user only. 

Running Easy-PC 26.0 

Once installed, an Easy-PC shortcut icon will appear on your desktop. 

This is also available on the Start panel in the Number One Systems 

folder. 

To start the program, double-click on the Easy-PC icon. 
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Chapter 2. New Features in Easy-PC V26 

 

IPC-2581 Output 

There is an IPC-2581 export option on the Output menu. This option is available in the PCB Design 

Editor and in the PCB Panel Editor. 

IPC-2581 is a modern CAD/CAM data exchange format which can be used as an alternative to 

Gerber, Excellon or ODB++ for manufacturing your PCBs. IPC-2581A format is exported. 

 

Use Browse to change the destination of the output file name and location. 

Choose the Units required for the IPC-2581 export. From the drop down list, choose Inches or mm. 

Functional Mode 

The IPC-2581 export is capable of outputting all or partial design files based on your requirements. 

From the drop down list, choose between FULL, DESIGN, FABRICATION, ASSEMBLY or 

TEST. Each of these modes will give you different portions of the design to suit the process it is 

intended for. 

The Level drop down list is available for all outputs except FULL. This enables you to choose the 

detail level for each functional mode selected. Choose between levels 1, 2, or 3. 

Layer Types 

In the IPC-2581 format the Silkscreen, Solder Mask, Solder Paste and Assembly layers need to be 

identified. Use the appropriate drop down list to select the Layer Types which will identify these 

layers. You can select (None) if you are not interested in the layer type. 

If there are no power planes in the design these options are suppressed. 

Neutral Net Names 

If this is checked then all user defined net names will output as numerical net names. This can be used 

to hide company specific net names, this will help protect your design IP. 
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Omit BOM Data 

The Omit BOM Data switch is available with any Fabrication Level set. Use this to remove the 

BOM data from the IPC-2581 file to hide company specific Parts names, this will help protect your 

design IP. 

Panel Editor Specific IPC-2581 Switches 

When running the Panel Editor, there is a switch that is only visible when running the IPC-2581 

option: 

 

By selecting the Output Each PCB Design Contents check box, a copy of each of all the PCBs in 

the panel are exported. With it not selected, only the contents of one PCB is exported. 

IPC-2581 Viewers 

There are IPC-2581 viewers available on the web, these enable you to verify the output before 

sending to external sources, this is highly recommended. 

IDF Export – New Output Options 

Remove illegal characters from Component Names 

Include/Exclude Component Values 

There are two new options in IDF export dialog: 

Remove illegal characters from Component Names 

Include (Exclude) Component Values 
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Remove Illegal Characters From Component Names - check this box to remove characters that are 

illegal in Component names for some programs, such as Inventor 3D. They will be replaced with an 

underscore. These characters include: \, /, :, *, ?, ", &gt;, &lt;, | 

Note: The IDF export option already did this for Version 3.0 formats but this new option lets you 

switch it off if required. 

Include Component Values - check this box to includes Component Values in the output file. This 

can only be for Version 3.0 formats. 

Exclude Off Board Items option for 3D View 

There is a new check box on the Edit menu, 3D Settings dialog called Exclude off-board items. 

When selected, this will prevent components and other items that are not entirely within a board 

outline will be excluded from the view. 

This can help for example if you have a standard drawing outline with title blocks, checking this box 

will exclude those portions that are not on a board. 

 

Navigate to Folder feature in Document Properties dialog 

Two small […] buttons have been added to the Document Properties dialog on the File menu, 

alongside the Path name of the design/project and the Technology file.  

Selecting these will open the corresponding folder in Windows File Explorer. 
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Improved Toggle Layers dialog 

The Toggle Layers dialog has been improved to make it more user-friendly. 

The changes reflect the Design Technology dialog layout and use a grid to contain the different 

toggles, this includes the Toggle Layer, Name and Layer/Side. 

 

Navigation 

The New button is used to create a new row and will take the first available grid. 

The Copy button will be enabled when the currently selected row (or cell within a row) contains 

commands. When clicked, the currently selected row will be copied to the next empty (free) row and 

will be selected. 

The Delete button will be enabled when the currently selected row contains commands and is not the 

first row. When clicked, the currently selected row will be deleted and the last row to have commands 

will be selected. 

The command list within the Layer Visibility grid section will be automatically filled with the 

commands in the newly selected row and the other controls will be populated with the details of the 

first layer rule in the list. If there are no commands in the newly selected row, then a new default layer 

rule will be added to the list and their details populated in the relevant controls. This is now ready to 

be edited. 

This dialog shows all the available Toggle Layer commands and their, if any, Name down the left 

side of the grid alongside a slot for specifying a command detailing the layer or layers to which each 

should apply. The commands can be modified by typing directly into the cell or, alternatively, 

constructed by using the set of controls at the bottom of the dialog. 

Layer Visibility Rule Controls 

This section consists of a list of layer rules shown on the right side and controls to create or edit a 

layer rule on the left side. The list of layer rules make up a toggle layer command. The controls on the 

left edit the currently selected (blue highlighted) rule in the list on the right. 
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Controls on the left side of this section will be enabled and disabled depending on the selection in 

other controls. For example, you can only define a side when a Layer Type has been selected from the 

Layer combination box. 

Like the controls on the left, the list buttons will be enabled and disabled based on the content in the 

list. 

The Add button starts a new layer visibility rule and adds a default rule to the list on the right. 

This is now ready to edit. 

The Remove button deletes the currently selected rule in the list. It will then select the next 

rule above (or below if nothing above) and automatically fill the controls on the left with their 

new values. 

The Move Up button moves the currently selected layer rule up one position. 

The Move Down button moves the currently selected layer rule down one position. 

Layers, Layer Type and Side 

The set of controls provided at the bottom of the dialog allow a new Layer Toggle command to be 

constructed or an existing Layer Toggle command to be edited. 

The Layer combination box contains all the layer names and types in the current PCB design grouped 

together by whether it is a layer name or layer type. A Layer must be selected to create a valid toggle 

layer command and specifies what layer(s) the command is to act on. 

As layer names can vary between designs it may be preferable to associate layers by characteristics 

rather than their explicit names. 

Side provides the additional optional field which allow for more detailed control when a Layer Type 

toggle is being created. 

Omitting Side and just specifying a Layer Type implies ALL layers of that type regardless of where 

they appear in the layer stack. 

Index is available if the Side is selected as Inner. This will be a numeric value that refers to the Inner 

layer in the sequence it appears (in the Inner Layers list). It might be a more suitable alternative 

choice when specifying a specific inner layer (rather than all inner layers) to use a named layer 

command instead. 

Omitting the Index when specifying Inner implies ALL inner layers, so "Electrical Inner" will toggle 

all the inner electrical layers. 

The Layer Name, Layer Type and Side are defined in the Design Technology dialog. 
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Changes to Rulers 

There are two new settings on the Ruler Settings context menu for Bar Size and Ruler Colour. 

 

Bar Size 

The Bar Size slider is used to increase or decrease the size of the ruler bar. This can be useful if you 

have a 4K monitor or if you wish to view it larger on a regular monitor. 

Ruler Colour 

Use the Bar Colour to change the background colour of the Ruler. Care should be taken when 

changing this so that you don’t loose the text colour on a dark background. 

Interactive Ruler Stops 

When you drag a ruler stop you can now see it move dynamically. You start the drag from the bar 

with menu items for additional functionality available on the context menu if you right click the 

mouse: 

 

There are options on the context menu to snap the ruler stop to the item you finish on. The snap to 

origin, extremes and drill edge work the same as the existing options from the ruler bar. The snap to 

item edge option will snap to the closest edge on the item. 

There are options on the context menu to snap the ruler stop to the item you finish on. Use the Snap 

To Origin, Snap To Item Edge, Snap To Item Extremes and Snap To Item Drill Edge Hole to 

snap to exact item positions. 
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Cancel Move After Paste 

There is a new option on the context menu called Cancel Move.  

 

This can be used when an item is copied and after paste. This will cancel the move of the item and 

release it back in its original position. 

If a section of design is cut from one design and pasted to another, the offset is not preserved. That 

means that if the original section has been critically positioned, the pasted section must be manually 

repositioned to the required location without the ability to use properties and type in exact co-

ordinates. The Cancel Move option allows the original position to be preserved. 

If the item is copied using Duplicate instead of Copy, the menu entry is still present but only while 

the item is on the cursor and dynamic, it disappears once the item is placed. 

Enhancements to the Goto Bar 

Goto Text 

A Text search has been added to the Goto Bar, this can find all ‘free’ Text and Values text in your 

current design. 

  

Choose Text in the Goto Bar as the ‘type’ and enter the text to find in the box. As you search for 

different text items in your design, the searched list will be populated. This can be refined using the 

Delete Search option from the context menu on the selected text string. 

Note, to find Component Names, like, R1, C1 etc. choose Values Text. 

New options on the context menu are available for Goto Text. 

Goto ‘type’ 

Type text to find here 

Recent Search list 
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This option can also be used to search for Values by selecting Find Values Matching Text from the 

context. 

Context menu commands 

Delete Search - Deletes the selected search from the list. 

Delete All Searches - Deletes all previous searches from the list. 

Find Exact Text - Only text matching the exact search string will be found. 

Find Values Matching Text - Use this to find items with Values containing text matching 

the search string.  
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Highlight Items in GoTo Bar 

There is a new option on Goto Bar context menu called Highlight Items From Design Selection. 

If you select items in the design, they will be highlighted in the Goto Bar (if it is pinned). It will 

highlight the relevant item e.g. if you select a Component and have Nets select in the Goto Bar, it will 

highlight the component net(s). 

 

Plotting & Printing - Move plots up and down in the Plot List 

There are two new buttons on the Plotting & Printing dialog available from the Output menu -   

Move Up and Move Down. These buttons allow you to reorder plots in the list, to sort them by type 

(Gerber etc.) for example. 
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Library Manager Report – Mark Missing Symbols 

Library Manager Report – Only Show Errors 

There are two new settings in Library report dialog - Mark Missing Symbols and Only Show 

Errors. This report is available from within the Library Manager on the Symbol and Component 

tabs. 

 

Mark Missing Symbols, will add the word, ‘Missing’, to the report if the symbol can’t be 

found. 

Only Show Errors, only reports missing symbols and reports  where a symbol is defined, but 

can't be found in an accessible library. 

Library Editor Synchronise Library Names 

When using the Library Manager, if a specific library is selected, User on the Component tab for 

example, when you now swap to another tab, Schematic Symbols for example, the program will try 

and choose the corresponding User symbol library if the same name exists. The Library Manager 

synchronises the library name across all tabs including 3D Packages and Associated Parts. 
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Inherited Net Name and Bus Name from Bus 

When starting or ending a Bus on the segment of an existing Closed Bus, it will now inherit the Net 

Name and Bus Name.  

 

New DRC & DFM Checks 

New checks have been added to enhance the Design Rules Checking for various design rules and 

Design For Manufacturing (DFM). When run, these checks will validate your design so that you have 

an additional level of confidence when sending it off for manufacture. 

Min Solder Mask Width 

A new check for Min Solder Mask Width has been added to the Manufacturing section in DRC.  

 

The minimum mask to track value can be set in the Design Technology under Rules and Solder 

Mask. 
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Long thin slivers of solder mask can potentially peel off during manufacturing, especially when under 

heat and should therefore be avoided. 

Minimum Solder Mask To Track 

A new check for Min Solder Mask To Track has been added to the Manufacturing section in 

DRC. The solder mask to track check will check any layer with a layer type that has the Min Mask 

To Track value defined (this value can only be defined on Non-Electrical layer classes). 

 

The minimum mask to track value can be set in the Design Technology under Rules and Solder 

Mask. 

 

This check ensures there is a minimum distance between a track and a solder mask opening (not 

including the opening for the tracks start and end nodes if they exist). 
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Modified Pour Areas 

A new check for Modified Pour Areas has been added to the Manufacturing section in DRC. When 

run, this check will give an error if a area has been modified (i.e. the area shape has changed, items 

inside area have changed or moved etc.) but the area has not been repoured. It requires the area to be 

poured first though. In addition, also run the additional existing DRC check - Unpoured Areas. 

 

Minimum Text Size 

A new check for Min Text Size has been added to the Manufacturing section in DRC.  

 

The min text size is defined in the Design Technology, Rules dialog on the Settings menu. Defining 

and running this check will ensure that all text added to your design is manufacturable, for example, 

copper or silkscreen text. 
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Ignore Same Component Errors 

There is a new setting in Design Technology and Spacings for No Same Component Errors.  

When set, DRC will ignore errors if they are in the same component, for example pad to pad spacing, 

or Silkscreen overlap checks. 

 

DRC only Check in Named Area 

From within the DRC option, there is now a check box to only check for errors inside a specific 

Named Area. 

 

Named areas are added using Add Component Area and then named using Properties and setting 

the name there. 

DRC in Schematics - Unconnected Gates 

Within the DRC option in a Schematic design, reporting common power pins as unconnected on 

additional gates now no longer reports this as an issue. 

Where gates are defined separately for heterogeneous devices, they may contain a power pin, 

especially if the same symbol has been used multiple times. Where the gate contains power pins for 

example, for the device to function, only one set of power pins must be connected on one of the gates. 

In this instance, this flagged an error in DRC. In Version 25 and previous version, common pins 7 and 

14 (for example) are connected on one gate but are flagged as "unconnected" on the other gates even 

though the device overall has the correct power pins connected. 
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In Version 25, it would be reported as an error like this on the additional three gates: 

 

In Version 26, these errors are now longer reported when DRC is run: 
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Invert Selection 

There is a new option on the context menu under Select, named Invert Selection. If you have items 

all of the same type selected, the selection will invert all items of that type. If you have different types 

selected, all unselected items will be selected. 

A practical example might include using Shift-select to pick one track path, Invert Selection to select 

all other tracks and then run the Mitre Selected Tracks or Smooth Selected Tracks options. 

 

Interactive Mitre/Fillet Any Angle in PCB 

In PCB, you can now interactively add/edit Mitres and Fillets for track that are at any angle instead of 

just right angles. To enable this option, use the Mitre/Fillet Any Angle switch on the Preferences 

PCB Interaction dialog. With this option disabled, you can only mitre orthogonal corners. 
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Apply Layout Pattern use Schematic Sheet 

On the Apply Layout Pattern dialog, there is now an option to select components from a Schematic 

Sheet. This is available for the Source pattern and the Target pattern. 

 

Select an existing Schematic design sheet from the Project. If the PCB was created without a project, 

only one sheet name will be available. 

Track Editing - Finish Track on Start Pad not allowed         

You can no longer finish a track when the track still inside the pad that it starts on. There are no 

practical situations where a track ever needs to start and finish within the same pad area, so the 

editing function has been tightened up to avoid this. Generally speaking, these are called dangling 

tracks and should be avoided. 

If you have created this situation on existing designs, they can be detected using the Design Rules 

Check option and subsequently resolved by manually editing the offending track. Use 'Next' from the 

context menu to select buried track (key <N>) or hold <Alt> when left clicking. 

Grid Visibility Setting on Layers Bar 

The Layers Bar has been updated to include the Grids check box on the bottom pane. Checking or 

unchecking this will change the display status of the Grids to either on or off. 
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Updated Change Layer Span dialog 

The Change Layer Span combo box is now a list and matches Change Style, it is a simple selection 

rather than a drop down, this will help save on mouse clicks. 
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Updated Change Layer and Track Layer dialogs             

The Change Layer combo box is now a list and matches Change Style, it is a simple selection rather 

than a drop down. This new style is used on Change Layer and Change Track Layer. 

 

Add Teardrop to Selected Pad only 

If you have a pad selected, you can use the new option to Apply Teardrop to Selected Pad. 

 

The result will look like this: 
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Likewise, once the teardrop is added, you can select the pad and remove the teardrop using the  

Remove Teardrop from Selected Pad option. 

Active Hyperlinks in Add Component and Add Component Bar 

In the Add Component dialog and Add Component Bar, Values that are hyperlinks will now be 

shown highlighted in blue. If you double click on the link, it will open it.  

 

The Add Component Bar shows this in the Values pane: 
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BOM Timestamp           

You can now add a timestamp to the BOM filename to make it unique. 
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BOM Cost Precision 

You can now change the precision of the component cost. 

 

BOM Multi-select Value Names 

When setting up the Values column, you can now select and add multiple Value names using the 

Shift and Ctrl keys. 

 

 


